
First Level / Microsoft Word 2010  Lab 7: Working with Shapes and Pictures 

 

Mustansiriyah University/ College of Dentistry  Lecturer: Mustafa H. Ali 

 

P
a

g
e
1
 

 
 

 

Inserting Clip Art 
 
Clip art is a collection of pictures and graphics 

that Microsoft has included with Word. 
 

 Click the Insert tab on the Ribbon and click the Clip 

Art button in the Illustrations group. 
 

The Clip Art task pane appears. 
 

Trap: Depending on how Word is installed and 

configured on your computer, an error message 

may appear, informing you that the clip art 

feature has not been installed. Try inserting the 

Office 2010 CD-ROM.  
 

 Type the name of what you’re looking for in the 

“Search for” text box. 
 

 Click the Results should be list arrow and check 

every box. 
 

 Tip: Select the Include Office.com content 

check box to include online items in your 

search results. 
 

 Click the Go button. 

 
 Scroll through the clip art until you find a file that 

you like. 
 

 Click the clip art that you want to insert. 
 

When you’re finished inserting clip art, close the 

Clip Art task pane. 
 

 Click the Close button in the upper-right corner of 

the Clip Art task pane. 
 

The task pane closes. 
 

Tips 
 
 A little star in the bottom-right corner of a graphic 

indicates animation.

 

 
 Exercise  

 Exercise File: American History7-1.docx 
 

 Exercise: Navigate to page 6. Open the Clip Art task 

pane and search for images of a lighthouse. 
 

Click the first image to insert it into the document.  
 
 
 
 

 
Type what you want 

to search for. 

 

 
Select the file type you 

want to search for. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 7-1: The Clip Art pane.  
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Inserting Screenshots 
 
A screenshot is an image of any visible item you see 

on your monitor. 
 

Insert a screenshot of an open window 
 

 Click the Insert tab on the Ribbon and click the 

Screenshot button list arrow in the Illustrations 

group. 
 

The Available Windows gallery appears. 
 

Tip: If a program window is minimized to the 

taskbar, it will not appear in the Available 

Windows gallery.  
 

 Select an image. 
 

The screenshot is inserted into the document. 

 

Insert a screen clipping 
 
Rather than inserting an entire window, use the Screen 

Clipping tool to take a screenshot of part of the window. 

 
 Make the window from which you want to take a 

screen clipping active. 
 

Tip: Minimize all programs to the taskbar 

except for the one from which you want to take a 

screen clipping.  
 

 In Word, click the Insert tab on the Ribbon and 

click the Screenshot button list arrow in the 

Illustrations group. 
 

A gallery of thumbnail images of all open 

program windows appears. 
 

 Select Screen Clipping. 
 

The Word window minimizes to the taskbar, the 

desktop fades, and the cursor changes to a crosshair. 

 
 Move the cursor to the corner of the area you want to 

clip. 
 

Tip: To cancel a screen clipping, press the 

<Esc> when the screen clipping screen is active. 
 
 

 Click and drag the cursor around the area you want to 

clip. 
 

The screen clipping is inserted into the document. 

 

 
 Exercise  

 Exercise File: American History7-2.docx 

and http://en.wikipedia.org 
 

 Exercise: Navigate page 2. In your web browser, look up 

Mount Rushmore in Wikipedia. Take a screen clipping of 

the Mount Rushmore picture.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 7-2: The Screenshot gallery is populated with 

thumbnails of all open program windows.  
 
 
 
 
 
 
 
 
 
 

 
Figure 7-3: Screen clipping in progress. 
 
 
 
 
 
 
 

 
Figure 7-4: A screen clipping in progress.  
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Inserting Pictures 

and Graphics Files 
 
In addition to inserting clip art into a document, you 

can also insert pictures or graphics that you have on 

file— such as pictures uploaded from a digital camera 

or graphics created in another program. 
 

 Click the Insert tab on the Ribbon and click the 

Picture button in the Illustrations group. 
 

The Insert Picture dialog box appears. 

 
 Navigate to the file you want to insert. 

 
 Click the name of the file that you want to insert and 

click Insert. 
 

The picture is inserted into the document as an inline 

image, and the Format contextual tab appears on the 

Ribbon under Picture Tools. 
 

Tips 
 
 If you don’t want the picture to appear inline with 

text, you’ll need to adjust its text wrapping.


 To insert more than one picture or graphics file at a 

time, press and hold down the <Ctrl> key as you 

click each file in the Insert Picture dialog box. 

 

 
 Exercise  

 Exercise File: American History7-3docx, Philadelphia.jpg 
 

 Exercise: Navigate to page 4 and insert the 

Philadelphia.jpg image located in the Practice folder.  
 
 
 
 
 
 

 

Table 7-1: Supported Graphics File Formats  

 Graphics Interchange Format .gif, .gfa 

 JPEG File Interchange Format .jpeg, .jpg, .jfif, .jpe 
   

 Microsoft Windows Bitmap .bmp, .rle, .dib 

 Portable Network Graphics .png 
   

 Tagged Image File Format .tiff 

 Microsoft Windows Metafile .emf, .wmf 
   

 Computer Graphics Metafile .cgm 

 Macintosh PICT .pct 
   

 WordPerfect Graphics .wpg 

 Encapsulated PostScript .eps 
   

 
 
 
 
 
 
 
 

 
Figure 7-5: When a graphic is inserted, the Format contextual tab appears on the Ribbon by default. These commands 

allow you to work with and format the selected picture. 
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Removing a Picture’s 

Background 
 
Word 2010 now has the ability to remove 

backgrounds from pictures and graphics. 
 

 Double-click the picture or graphic from which you 

want to remove the background. 
 

The Format contextual tab appears on the 

Ribbon under Picture Tools. 
 

 Click the Remove Background button in the Adjust 

group on the Format contextual tab of the Ribbon. 
 

The Background Removal program tab appears 

on the Ribbon and the area that will be removed 

from the picture or graphic appears in purple. 
 

 Click and drag the sizing handles of the inlaid 

rectangle around the area you want to keep. The 

area identified as the background changes. 

It is unlikely that Word will get it exactly right, 

so you will have to refine the areas to be kept and 

removed. 
 

 Click Mark Areas to Keep button or the 

Mark Areas to Remove button in the Refine 

group. The cursor changes to a pencil. 
 

 Click the drag the mouse over the areas of the image 

that you want to keep or remove. 
 

A line is drawn across the area. It changes 

depending on whether you want to keep it or not. 
 

 To remove a mark, click the Delete Mark button 

in the Refine group and click on the mark you 

want to delete. 
 

The mark removed. 

 
 When you are finished, click the Keep Changes 

button in the Close group. 
 

The background is removed and Word returns to 

Print Layout view. 
 

Tip: To return the image to its original 

state, double-click the image, click the 

Remove Background button and click 

Discard All Changes.   

Tips 
 
 Try experimenting with different styles or fills to 

replace the removed background.

 

 
 Exercise  

 Exercise File: American History7-4.docx 
 

 Exercise: Navigate to page 2. Remove the background 

from the image. Refine as necessary.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 7-6: Removing the background from a picture.  
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Altering the Look of Pictures 

and Graphics 
 
Word 2010 has greatly expanded the user’s ability to 

alter the appearance of pictures and graphics. Now you 

can easily sharpen or soften an image, change brightness 

and contrast, adjust coloring, and apply artistic effects. 
 

Apply corrections 
 
Corrections that can be applied include sharpening or 

softening, and adjusting the brightness and contrast. 
 

 Double-click the picture or graphic to which 

you want to apply corrections. 
 

The Format contextual tab appears on the 

Ribbon under Picture Tools. 
 

 Click the Corrections button in the Adjust group 

on the Format contextual tab of the Ribbon. 
 

A gallery of corrections options appears. 

 
 Select a correction option from the gallery. 

The picture or graphic corrected accordingly. 
 

Tip: To preview how the correction will 

change your picture or graphic, briefly hold the 

mouse over the correction option.  
 

Adjust color 
 
When you adjust color, you can change the color 

saturation, color tone, or simply re-color the image. 

 
 Double-click the picture or graphic for which 

you want to adjust color. 
 

The Format contextual tab appears on the 

Ribbon under Picture Tools. 
 

 Click the Color button in the Adjust group on 

the Format contextual tab of the Ribbon. 
 

A gallery of color options appears. 

 
 Select a color option from the gallery. 

 
The picture or graphic is re-colored accordingly. 

 
Tip: To preview how the color adjustment will 

change your picture or graphic, briefly hold 

the mouse over the color option  

 

 
 Exercise  

 Exercise File: American History7-5.docx 
 

 Exercise: Navigate to page 2. Apply the 

Temperature: 8800K Color Tone. 
 

Apply the Marker artistic effect.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7-7: The Corrections gallery.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7-8: The Color gallery.  
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Apply artistic effects 
 
Perhaps the most interesting new feature for image 

adjustment is the ability to apply artistic effects. You can 

make your picture or graphic appear as if it was painted or 

drawn with the click of a button. 
 

 Double-click the picture or graphic to which 

you want to apply an artistic effect. 
 

The Format tab appears on the Ribbon under Picture 

Tools. 
 

 Click the Artistic Effects button in the Adjust 

group on the Format contextual tab of the Ribbon. 
 

A gallery of artistic effects appears. 

 
 Select an artistic effect from the gallery. 

 
The artistic effect is applied accordingly. 

 
Tip: To preview how the artistic effect will 

change your picture or graphic, briefly hold 

the mouse over the effect.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 7-9: The Artistic Effects gallery.  
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Formatting Pictures or 

Graphics 
 
Word comes with several features that allow you to alter 

a picture or graphics file once it has been inserted. 
 

Crop a picture or graphic 
 
When you crop a picture or graphic, you trim its 

horizontal and vertical sides. Cropping is useful when 

you only want to include a portion of a picture or graphic. 
 

 Double-click the picture or graphic that you want to 

crop. 
 

The Format contextual tab appears on the 

Ribbon under Picture Tools. 
 

 Click the Crop button list arrow in the Size group. 
 

A list of options appear. See the table to the right, 

Cropping Options, for a description of each option. 

 
 Click Crop. 

 
 Click and drag the picture or graphic’s 

cropping handles. 
 

Word crops the picture or graphics. 
 

Tip: To crop all four sides of a picture or 

graphic at once while maintaining the graphic’s 

proportions, press and hold down the <Ctrl> key 

as you drag the mouse.  
 

 Click the Crop button in the Size group once again 

to turn off the cropping tool. 
 

The image is cropped. 

 

Change the visual style of a picture or 

graphic 
 
Changing the visual style of a picture or graphic 

changes how it appears on the page. 
 

 Double-click the picture or graphic that you want to 

adjust. 
 

The Format contextual tab appears on the 

Ribbon under Picture Tools. 
 

 Select a style from the Picture Styles group. 
 

 Tip: To view all the available styles, click the  
More button ( ) in the Picture Styles group to 

view the Picture Styles gallery. 
 

The style is applied to the picture or graphic. 

 

 
 Exercise  

 Exercise File: American History7-6.docx 
 

 Exercise: Navigate to page 4 and crop the picture. 

Apply the Rotated, White picture style to the image. 

 
 
 
 
 
 
 
 
 
 

 
Figure 7-10: The Size group on the Format tab.  
 
 
 
 

Table 7-2: Cropping Options  

 Crop to Shape Crops your graphic to fit inside a shape 

  selected from the gallery. 

 Aspect Ration Crops your picture or graphic according 

  to an aspect ratio. 
   

 Fill Resizes the picture so that the entire 

  picture area is filled while keeping the 

  aspect ratio. Use when enlarging an 

  image. 

 Fit Resizes the picture so that the entire 

  picture area is filled while keeping the 

  aspect ratio. Use when shrinking an 

  image. 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7-11: The Picture Styles gallery.  
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Inserting Shapes 
 
Word 2010 comes with an extensive set of ready-made 

shapes, called AutoShapes that you can use to easily 

draw shapes on your documents. The Shapes gallery 

contains over a hundred common shapes and lines, such 

as stars, arrows, and speech balloons. 
 

Draw a shape 
 
To insert a shape into a document, draw it. 
 

 Click the Insert tab on the Ribbon and click the 

Shapes button in the Illustrations group. 
 

The AutoShapes gallery appears. 
 

 Click the shape you want to insert. 
 

The arrow pointer changes to a crosshair. 
 

 Click and drag on the page or drawing canvas 

until the shape reaches the desired size. 
 

Tip: To draw a straight line, perfect square or 

circle, or to constrain the dimensions of other 

shapes, press and hold down the <Shift> key 

as you drag.   
 Release the mouse button. 

 
The shape is inserted and the Format contextual 

tab appears on the Ribbon under Drawing Tools. 
 

Adjust a shape 
 
You can adjust the most prominent feature of a shape— 

such as the point on an arrow or the spikes on a star—by 

using its adjustment handle. 
 

 Click the shape you want to adjust. 
 

 Click and drag the shape’s adjustment handle ( ), 

and release the mouse button when you’re 

finished. The shape is adjusted. 
 

Tip: Some shapes have more than one adjustment 

handle, while others don’t have any at all. 
 
 

Add text to a shape 
 
Adding text to a shape is extremely easy. 

 

Click the shape you want to add to and start typing. 
 

Other Ways to Add Text to a Shape: Right-

click the shape you want to add text to, select 

Add text from the contextual menu, and type 

your text.  

 

 
 Exercise  

 Exercise File: American History7-7.docx 
 

 Exercise: Navigate to page 3. Draw a 16-point star 

over the Statue of Liberty image.  
 

 

Table 7-3: AutoShape Categories  

 Lines Straight lines, curved lines, scribbled 

  lines, arrows, and free form drawing 

  shapes. 

 Basic Shapes Squares, rectangles, triangles, circles, 

  pentagons, and more. 
   

 Block Arrows Arrows that point up, down, left, and 

  right. 

 Flowchart Basic shapes used to create flowcharts. 
   

 Callouts Text box shapes that point to and 

  describe something. 

 Stars and Banners Shapes that boldly announce 

  something. 
    
 
 
 

 
Figure 7-12: Click and 

drag to create an 

AutoShape.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 7-13: Click and drag the adjustment handle 

to change the AutoShape.  
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Formatting Shapes 
 
The first thing you’ll probably want to do after inserting a 

shape is change its fill and outline color. This lesson will 

show you how to format a shape. 
 

Change the fill color of a shape 
 
You can add, adjust, or remove the fill color of the 

shapes you create in Word. 
 

 Double-click the shape whose fill color you wish to 

change. 
 

The Format contextual tab appears on the 

Ribbon under Drawing Tools. 
 

 Click the Shape Fill button list arrow in the Shape 

Styles group. 
 

The Shape Fill menu appears. You have several 

options to choose from here, as shown in the Shape 

Fill Options table. 
 

 Select an option from the menu. 
 

Other Ways to Change the Fill Color of a  
Shape: 

Right-click the shape and select Format Shape 

from the contextual menu. Click the Fill tab, 

select your options, and click Close when 

you’re finished. 
 

Change the outline of a shape 
 
You can add an outline to shapes or adjust or remove 

an existing outline. 
 

 Double-click the shape whose outline you wish to 

change. 
 

The Format contextual tab appears on the 

Ribbon under Drawing Tools. 
 

 Click the Shape Outline button in the Shape Styles 

group. 
 

The Shape Outline menu appears. You have 

several options to choose from here as shown in 

the Shape Outline Options table. 
 

 Select an option from the menu. 
 

Other Ways to Change the Outline of a 

Shape: Right-click the shape and select Format 

Shape from the contextual menu. Click the Line 

Color tab to add a line, click the Line Style tab 

to select your options, and click Close when 

you’re finished.  

 

 
 Exercise  

 Exercise File: American History7-8.docx 
 

 Exercise: Navigate to page 3 and apply a yellow fill color 

to the star shape. 
 

Then apply a thick, orange outline color to the shape.  

 
Table 7-4: Shape Fill Options 

 

 Theme Select a fill color from the colors 

 Colors in the current theme. 

 Standard Select a fill color from one of 

 Colors the 10 standard colors. 
   

 No Fill Removes the fill color. 

   

 More Fill Select a fill color from one of 

 Colors the thousands of colors in the 

  Colors dialog box. 
   

 Picture Fills the shape with a graphic 

  you have on file. 

 Gradient Color gradually changes from 

  one color to another. 
   

 Texture Fills the shape with a texture. 

    
 
 
 
 
 
 
 
 
 
Figure 7-14: The Shape Styles group.  
 

 
Table 7-5: Shape Outline Menu  

 Theme Select an outline color from the 

 Colors colors in the current theme. 

 Standard Select an outline color from one 

 Colors of the 10 standard colors. 
   

 No Removes the outline. 

 Outline  

 More Select an outline color from one 

 Outline of the thousands of colors in the 

 Colors Colors dialog box. 
   

 Weight Changes the thickness of an 

  outline. 
   

 Dashes Changes the look of the outline. 

   

 Arrows Changes the look of an arrow 

  shape. 
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Change the visual style of a shape 
 
Changing the visual style of a shape is an easy way to 

spice up its appearance. A visual style is a set of 

different formatting commands that can be applied to a 

shape in one single step. 
 

 Double-click the shape that you want to change. 
 

The Format contextual tab appears on the 

Ribbon under Drawing Tools. 
 

 Select a style from the Shape Styles group. 
 

 Tip: To view all the available styles, click 

the More button ( ) in the Shape Styles 

group to display the Styles gallery. 
 

The visual style is applied to the shape. 
 

Tips 
 
 The colors of the Shape Style options change with the 

document theme and/or theme color.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7-15: The colors available in the Shape 

Style gallery change with the Theme Color.  
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Resizing, Moving, Copying, 

and Deleting Objects 
 
More often than not, the objects that you insert into 

your documents will need to be modified in order to 

coincide with the other elements in a document. This 

lesson will show you how to resize, move, copy, and 

delete the shapes and graphics in your documents. 
 

Resize an object 
 
Make an object larger or smaller by resizing it. 

 

 Click the object to select it. 
 

Sizing handles appear around the object once it is 

selected. You can use these sizing handles to change 

the size and proportions of the selected object. 

 
 Click and drag one of the object’s sizing handles. 

 
Tip: To maintain the object’s proportions while 

resizing, hold down the <Shift> key as you drag. 
 
 

 Release the mouse button. 

 

Move an object 
 
By simply clicking and dragging with the mouse, you 

can move an object to a new location on the page. 
 

 Click and drag the object to a new location. 

 
 Release the mouse button when the object is 

positioned where you want it. 
 

Copy an object 
 
You can also copy an object by clicking and dragging— 

simply press and hold the <Ctrl> key as you drag. 

 
 Press and hold down the <Ctrl> key, and click 

and drag the object to a new location. 
 

 Release the mouse button, and then release the key. 

 

Delete an object 
 
If you decide you don’t want an object, delete it. 

 

Select the object that you want to delete and press the 

<Delete> key. 
 

The object is removed from the document. 

 

 
 Exercise  

 Exercise File: American History7-9.docx 
 

 Exercise: Navigate to page 2 and enlarge the Mount 

Rushmore image so that it is half its original size. 
 

Then, navigate to page 5 and make a duplicate of the 

cowboy hat image. 
 

Delete the duplicate image.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 7-16: To resize an object, click one of its 

sizing handles and drag to the new size.  
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Positioning Objects 
 
Whenever you insert a graphic into a document, it is 

inserted inline with text by default. This means that the text 

in the document moves in order to accommodate the 

graphic. This lesson will show you how to adjust text 

wrapping and how to use the grid to position objects. 

 

Adjust text wrapping 
 
To adjust how text reacts to the objects in your 

documents, change the object’s text wrapping. 

 
 Double-click the object whose text wrapping you 

wish to adjust. 
 

The Format contextual tab appears on the Ribbon. 

 
 Click the Wrap Text button in the Arrange group. 

 
A list of text wrapping styles appears. Take a look 

at the Text Wrapping Styles table for a description 

of each style. 
 

 Select a text wrapping style from the list. 
 

The text wrapping style is applied to the image. 
 

Other Ways to Adjust Text Wrapping:  
Right-click the image, point to Wrap Text in 

the contextual menu, and select an option from 

the submenu. 
 

Display/hide the grid 
 
Just like the graph paper you used to use in geometry 

class, the grid consists of horizontal and vertical lines 

that help you draw and position objects. 
 

 Click the View tab on the Ribbon. 

 
 Click the Gridlines check box in the Show group. 

Horizontal and vertical gridlines appear on the page. 

Tips 
 
 Gridlines do NOT appear in the printed document.
 

Adjust grid settings 
 
To adjust grid settings, such as how much space appears 

between gridlines, open the Drawing Grid dialog box. 

 
 Click the Format contextual tab on the Ribbon. 

 
Tip: If the Format contextual tab isn’t 

displayed on the Ribbon, double-click an object 

in the document to display it.  

 

 
 Exercise  

 Exercise File: American History7-10.docx 
 

 Exercise: Navigate to page 6 and change the text wrapping 

style of the lighthouse image to “Tight”. 
 

Display the grid, then turn off the Snap to Grid feature. 

Hide the grid. 

 
 

Table 7-6: Text Wrapping Styles  

  
In Line 

This places the object at the insertion 
  point in a line of text in the document.   

with   The object remains on the same layer as   

Text   the text. This is the default setting. 
   

    

  
Square 

Wraps text around all sides of the square 
  

bounding box for the selected object.    
    

  
Tight 

Wraps text tightly around the edges of the 

  actual image (instead of wrapping around 

   the object's bounding box). 

  
Through 

Similar to the Tight option, this option 
  

wraps text throughout the image.    
    

  
Top and 

Wraps text around the top and bottom of 
  the object, leaving the area to the right   

Bottom   and left of the object clear.    

    

  
Behind 

This removes text wrapping and puts the 
  object behind text in the document. The   

Text   
object floats on its own layer.    

    

  
In Front 

This removes text wrapping and places 

  the object in front of text in the 

  of Text document. The object floats on its own 

   layer. 
     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 7-17: The page with the grid displayed.  
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 Click the Align button in the Arrange group 

and select Grid Settings from the list. 
 

The Drawing Grid dialog box appears. 

 
 Make your adjustments and click OK when you’re 

finished. 
 

Turn on/off the Snap to Grid feature 
 
The Snap to Grid feature causes objects to “snap” to the 

nearest gridline when you move them around in your 

documents. This can be convenient or extremely 

inconvenient depending on your personal preferences. 
 
The Snap to Grid feature is turned off by default in 

Word 2010, but you can easily turn it on. 
 

 Click the Format contextual tab on the Ribbon. 
 

Tip: If the Format contextual tab isn’t 

displayed on the Ribbon, double-click an object 

in the document to display it.  
 

 Click the Align button in the Arrange group 

and select Grid Settings from the menu. 
 

The Drawing Grid dialog box appears. 
 

 Click the Snap objects to grid check box. 
 

Tip: To set this as the default setting, click Set 

as Default in the Drawing Grid dialog box. 
 
 

 Click OK. 

 
 
 

 
Align  

 
 
 
 

 
Figure 7-18: Click the Align button in the Arrange group 

to align objects and adjust grid settings. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7-19: Adjust grid settings in the Drawing 

Grid dialog box. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



First Level / Microsoft Word 2010  Lab 7: Working with Shapes and Pictures 

 

Mustansiriyah University/ College of Dentistry  Lecturer: Mustafa H. Ali 

 

P
a

g
e
1

4
 

 
 

 

Applying Special Effects 
 
You can apply special effects such as reflection, glow, 

and 3-D rotation to clip art, shapes, and pictures. 
 

 Double-click the picture that you want to 

apply special effects to. 
 

The Format contextual tab appears on the 

Ribbon under Picture Tools. 
 

 Depending on the object, click the Picture Effects 

button in the Picture Styles group or click the 

Shape Effects button in the Shape Styles group. 
 

A list of different types of effects appears. 

 
 Point to the type of effect that you want to use, 

then select an option from the submenu. 
 

The special effect is applied to the picture. 
 

 Tip: To preview how a special effect will 

change your image or object, point to different 

effects in the gallery. 

 

 
 Exercise  

 Exercise File: American History7-11.docx 
 

 Exercise: Navigate to page 5 and apply a glow effect to 

the first rectangle shape. 
 

Apply the special effect of your choice to the second and 

third rectangle shapes.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7-20: The Picture Effects gallery.  
 
 

Table 7-7: Special effects  
 
 
 
 

 

Preset 
Shadow 

 
 
 
 
 
 

Glow  
Reflection  

 
 
 
 

 
Soft Edges Bevel  

 
 
 
 
 

 
3-D Rotation  
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Grouping Objects 
 
It is often easier to work with a single object than it is to 

work with several smaller objects. A group is a 

collection of objects that Word treats as a single object. 
 

Select multiple objects 
 
Before you can work with multiple objects, you 

must select them. 

 
Press and hold down the <Shift> or <Ctrl> key as 

you click each object that you want to select. 
 

Group objects 
 
By grouping several objects together you can format an 

entire group of objects rather than formatting each 

object individually. 
 

 Select the objects that you want to group and click 

the Format contextual tab on the Ribbon. 
 

 Click the Group button in the Arrange group 

and select Group from the list. 
 

Other Ways to Group Objects:  
Select the objects that you want to group. Then, 

right-click one of the selected objects, point to 

Group in the contextual menu, and select Group. 

 

Ungroup objects 
 
If you need to make changes to an object that is part of a 

group, you’ll need to ungroup the objects first. 
 

 Select the group of objects that you want to ungroup 

and click the Format contextual tab on the Ribbon. 
 

 Click the Group button in the Arrange group, 

and select Ungroup from the menu. 
 

The selected objects are ungrouped. Now you 

can work with each object individually. 
 

Other Ways to Ungroup Objects: Right-

click the group, point to Group in the 

contextual menu, and select Ungroup from 

the submenu.  

 

 
 Exercise  

 Exercise File: American History7-12.docx 
 

 Exercise: Navigate to page 5 and group the rectangles and 

arrows. Then, ungroup the objects.  
 
 

 
Select multiple objects by 

holding down the <Shift> key 

as you click each object…  
 
 
 
 
 
 
 
 

 
…or by drawing a box 

around the objects 

you want to select. 

 
 
 

 
Figure 7-21: Selecting multiple objects in a document.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 7-22: You can also use the contextual menu 

to group and ungroup objects. 
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Aligning and 

Distributing Objects 
 

Align objects 
 
Documents that have pictures and graphic scattered 

randomly about them look terrible. This lesson will 

show you how to use the Align and Distribute features to 

organize the objects in your document. Align objects 
 
The Align command aligns objects relative to one another. 

 

 Select the objects that you want to align. 

 
 Click the Format contextual tab on the Ribbon 

and click the Align button in the Arrange group. 
 

A list of alignment options appears. 

 
 Select an alignment option from the menu. 

The selected objects are aligned accordingly. 

 
Distribute objects 
 
The Distribute command spaces objects evenly. 

 

 Select the objects that you want to distribute. 

 
 Click the Format contextual tab on the Ribbon 

and click the Align button in the Arrange group. 
 

You can distribute objects vertically or horizontally. 

 
 Select a distribution option from the list. 

 
The selected objects are distributed accordingly. 

 

 
 Exercise  

 Exercise File: American History7-13.docx. 
 

 Exercise: Navigate to page 7 and align the Legislative, 

Executive, and Judicial images with the bottom-most image. 

Then, distribute the objects horizontally.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 7-23: The selected objects are aligned so that the 

top edges are even. 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 7-24: The selected images are distributed horizontally.  
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Flipping and Rotating Objects 
 

Flip an object 
 
When you flip an object, you create a mirror image of 

it. Word allows you to flip an object horizontally or 

vertically. 
 

 Double-click the object that you want to flip. The 

Format contextual tab appears on the Ribbon. 

 Click the Rotate button in the Arrange group. 
 

 Select Flip Vertical or Flip Horizontal from the 

list. The object is flipped accordingly. 

 
Rotate an object 
 
When you rotate an object, you turn it around its center. 

You can rotate objects in 90-degree increments or you 

can use the rotation handle to rotate an object manually. 
 

 Select the object that you want to rotate. 

A green rotation handle ( ) appears. 
 

 Click and drag the object’s rotation 

handle. Word rotates the selected object. 
 

Other Ways to Rotate an Object: Double-

click the object that you want to rotate, click the 

Rotate button in the Arrange group and select 

Rotate Right 90° or Rotate Left 90° from the 

list.  
 

Rotate an object with greater precision 
 
Using an object’s rotation handle is the fastest and 

easiest way to rotate an object, but you can rotate an 

object with greater precision using a dialog box. 
 

 Double-click the object that you want to rotate. The 

Format contextual tab appears on the Ribbon. 

 Click the Rotate button in the Arrange group 

and select More Rotation Options from the list. 
 

A dialog box appears, offering rotation options 

relative to the type of object that is selected. 
 

 In the Rotation box, enter the number of degrees 

that you want to rotate the object. 
 

 Click OK to close the dialog box. 

The object is rotated accordingly. 

 

 
 Exercise  

 Exercise File: American History7-14.docx 
 

 Exercise: Navigate to page 5 and flip the upward-pointing 

arrow shape so that it faces downward. Then, rotate the 

second arrow shape so that it faces downward.  
 
 
 
 
 

 
Rotate 

 

 

Figure 7-25: The Rotate button in the Arrange group.  

 

Table 7-8: Flip and Rotate Commands  
 
 

 

Original Picture 
 

Free Rotate  
 
 
 
 

 

 Rotate Right Rotate Left 
   

 Flip Vertical Flip Horizontal 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 7-26: The Layout dialog box.  
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Layering Objects 
 
How can you make sure one object on a page appears in 

front or in back of another object? Word solves this 

problem by layering objects, like a stack of papers. 
 
There are four layering commands in Microsoft Word: 
 

Bring to Front: You can choose to Bring to 

Front, Bring Forward, or Bring in Front of Text 

with this command. 
 

Send to Back: You can choose to Send to Back, 

Send Backward, or Send in Behind Text with this 

command. 
 

Bring Forward: Brings the selected object up 

one layer. 
 

Send Backward: Sends the selected object down 

one layer. 
 

Tips 
 
 By default, the first object that you insert in a 

document is assigned to the bottom layer of the 

page. Each object that you insert thereafter is 

assigned one level above, and so on. The final object 

that you insert will appear on the topmost layer.
 

 Double-click the object that you want to layer. The 

Format contextual tab appears on the Ribbon. 

 
 Click the Bring Forward or Send Backward button 

in the Arrange group, or click the Bring Forward or 

Send Backward button list arrow and select an 

option from the list. 
 

The object is layered accordingly. 
 

Other Ways to Layer an Object:  
Right-click the object that you want to layer, 

point to Bring to Front or Send to Back in the 

contextual menu, and select an option from the 

submenu. 

 

 
 Exercise  

 Exercise File: American History7-15.docx 
 

 Exercise: Navigate to page 3 and move the star shape 

behind the Statue of Liberty.  
 
 
 

 
3 

 

 Layered objects, as 
they appear onscreen.

 

 
1  

 
 
 
 

 

3 

Layered objects are 
simply stacked on top 

2 of one another, like 

1 
sheets of paper. 

 

 

 
Figure 7-27: Layered objects.  

 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7-28: Layering allows you to stack objects on top  
of each other.  
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Inserting a Text Box 
 
A text box is a special type of drawing object that lets 

you insert and position text anywhere in a document. 
 

Insert a built-in text box 
 

 Click the Insert tab on the Ribbon and click the Text 

Box button in the Text group. 
 

A list of built-in text box options appears. 

 
 Select a built-in text box to insert in the document. 

 

Create a text box 
 
You don’t have to use one of Word’s built-in text 

boxes; you can create your own. 
 

 Click the Insert tab on the Ribbon and click the Text 

Box button in the Text group. 
 

 Select Draw Text Box from the list. 
 

The arrow pointer changes to a crosshair, 

indicating you can draw the text box. 
 

 Click and drag on the page, until the text box reaches 

the desired size. 
 

 Click in the text box and type your text. 

 

Link text boxes 
 
Linking text boxes allows text to flow between them. 

For example, you could make the text of an article flow 

through several text boxes. 
 

 Enter text into a text box and select the text box. 
 

In order to link the text box to a new one, there has to 

be more text in the text box than can be shown. 
 

 Under Text Box Tools, click the Format tab and 

click the Create Link button in the Text group. 
 

The cursor changes into a pitcher full of letters . 

The pitcher will change to indicate it is ready to 

“pour” text into a text box. 
 

 Place the pitcher over an empty text box and click. 
 

Tips 
 
 Formatting a text box is similar to formatting a shape. 

You can also format the text in a text box just as you 

would any other text.

 

 
 Exercise  

 Exercise File: American History7-16.docx 
 

 Exercise: Navigate to page 7 and draw a text box 

underneath the Judicial image (the courthouse image on the 

right). 
 

Type “Judicial” in the text box, center the text, and remove 

the text box border.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7-29: This is an example of a built-in text box.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 Click the Create Link button when the text box with 

overflow text is selected. Place the pitcher full of letters 

over the empty text box. 

 

 

 

 

 

 

 

 The text boxes are linked and the text flows between them. 
 
Figure 7-31: Linking text boxes.  

 

 

Reference: 
 


